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A set of records, a book, newspaper cuttings, lists of names, or other records have been
identified as worthy of indexing.
What sort of index should be made? Should a full transcription be made? Should it be indexed
on cards? If a computer is used what programme should be used? Should the index be
published? If so, in what form?
Following is a guide to indexing and some information to enable you to start and finish a project
in the most efficient manner.
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What sort of index?
A simple index giving names and reference numbers will enable a researcher to go back to the
original documents. The NZSG has a set of guidelines to creating a simple index. See pages 4
and 5.
Full Transcriptions
A full transcription converts all the information in a record into uniform tabulated fields. Full
transcriptions offer full protection for the original record against loss or damage. However, there
are a number of reasons why this is not the best option for indexing. Firstly, a full transcription
will usually take much longer to compile. The more records requiring indexing the longer it will
take.
Full transcriptions can be taken out of context. A simple index will lead the researcher to the
document where it will be seen with the contemporaneous entries and these may help to build a
better understanding of the entry.
An opportunity exists for a genealogical group, historical society, museum or archive to
advertise and create an income stream from a simple index whereas a full transcription may not
lead to an enquiry.
Computer or Card Indexes
Computer indexes are much more versatile than card indexes. A card index is still useful but it
has many disadvantages. It can become extremely large, be subject to misfiling, and as it
usually can only be housed in one location could be subject to loss.
A computer index can easily be held in a number of locations, can be sent by email and even a
novice can help to create such an index.
Computer Programmes
It is not necessary to have a special computer programme to create a simple index. It is
suggested that a spreadsheet programme be used. The NZSG standard spreadsheet
programme is Microsoft Excel®, but you can use Open Office. Indexes created in a spreadsheet
can be easily transferred into another programme for searching. An indexing format is available
on request from NZSG.
Publication
The restrictions of the Privacy Act must be fully considered before publication. This does not
need to restrict what is indexed – only what is published. When publishing, details of the project
need to be outlined together with the scope and the source of the information. It should also
include particulars of how researchers can locate the original together with restrictions, if any.
Other details such as the length of time the project has taken along with those who have
assisted with the project can be included.
The NZSG can assist in the publication of Indexing and Transcription Projects. If the project
meets the Approval criteria the NZSG may undertake the publication with a 50/50 profit sharing
agreement. The NZSG will fund the production and when all set up costs have been paid will
distribute the profit on a regular basis. The NZSG has its own search engine which has been
used for other publications on CD Rom.
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Criteria for an NZSG Indexing Project


Records of historical and genealogical value



Records with mainly New Zealand associated content



Records of local, regional or national importance



Records unique to a specific area, time or occupation



Transcriptions made in a format acceptable to NZSG



Project managed in accordance with NZSG instructions.

Priority will be given to


Records that are more than 75 years old



Records which are “at risk”



Records where the completed projects will be readily available to members of the NZSG.

Many people commence projects that have already been done by others. Check the NZSG
Projects Register.
The NZSG has the forms for Registering a Project (F9) and the forms for Releasing Records for
transcribing by a Repository (F10). Download the forms from the NZSG website.
Training of Indexers
The NZSG holds training sessions for prospective indexers. These are generally held at the
FRC, 159 Queens Road, Panmure and are a “hands on” workshop using computers and a
spreadsheet. Alternatively, a trainer could be sent to your area.
Attendees should be reasonably familiar with using a computer. If not then they need to attend
one of our “Scared of the Mouse” or “Introduction to Computers” courses prior to the “Indexing
Workshop”. There may be similar free courses at a Community College or Senior Net group in
your locality.
Indexing Groups
NZSG members working within a repository are volunteering their time and are creating an
index for both the NZSG and the repository. The NZSG has a Volunteer Agreement (F43) which
needs to be signed prior to commencement of the project (download from the NZSG website).
Financial Assistance
The NZSG has a project budget and some financial assistance may be available for Approved
Projects. Typically this will be for photocopying, stationery and postage. However, applications
must be made to the Projects Management Committee before any of these costs is incurred as
under no circumstances will costs be covered which have been incurred prior to approval being
given. An application form for Project Funding is available on the NZSG website.
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Copyright
The copyright of the original material is determined by The Copyright Act 1994 but generally will
be held by the Repository. The copyright of an index created by NZSG members for the NZSG
will be held by the NZSG.
Assistance and Support
For further assistance and support please contact:
The Projects Management Committee
New Zealand Society of Genealogists
P O Box 14036, Panmure
Auckland, 1741

Telephone 09 570 4248
Fax 09 570 4238

NZSG Indexing Standards
The following are standards for a simple index. These are not standards for a transcription.
Key what you see – this means that what is on the page is what is typed or keyed. The
exception is for full stops and some punctuation. It is now common practice not to enter full
stops when typing initials.
Examples:
Rev.
Reverend
Esq.
Sister
Fr.
P.A. Brown

Entered as Rev not Reverend
Entered as Reverend
Entered as Esq not Esquire
Entered as Sister
Entered as Fr
Entered as Brown (first field) P A (omit the full stops but put a space
between the initials)

A spreadsheet is used to enter the data. Set it up like this:
1st Row
2nd Row
3rd Row

4th Row

Enter the name of the book or publication in full including author
Leave blank
Enter the headings in the following order:
Surname
Given Names
Title (i.e. Mr, Mrs, Rev etc)
Page
Comments
Begin your data entry. After the first row, save your work and save at
frequent intervals thereafter.

You may extend the columns by left clicking and holding on the line between the
column letters (e g A | B) until a straight line and a double arrow appears, then drag
to the right.

Important! Remember to save frequently and copy to a flash drive, pen drive, floppy disk,
or CD Rom at the end of your current session.
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Data Entry Hints
Surname

Enter as it appears in the document paying particular attention to spaces,
hyphenated names and lower case prefixes. For example: McDonald,
Macdonald, Vandenberg, Van den Berg, Deslandes, Des Landes.

Given names

Only include these where they are connected to a surname. For example,
if in the text it says “Bill went to …” you would ignore this name. However,
if it said “Bill Brown went to …” you would index this name.

Title

Where in the text “Mr and Mrs Henry Brown did …” enter each name
separately:
Brown
Brown

Henry
Henry

Mr
Mrs

Page

Some smaller publications do not number the pages. Number the pages in
pencil allocating the cover as 1. Often publications have names recorded
on the pages before the numbering commences. Number these in pencil
with roman numerals, i.e. i, ii, iii, iv, v, vi, vii, viii, ix, x, etc

Comments

Short comments only should be recorded. For example: group photo;
headstone transcription; Parish register entry.

Age

Years only. However if the records have ages in years, months, weeks,
days, or hours it may be appropriate to set these up in two columns the first
recording the numeral and the second recording the unit expressed as y
(years) m (months) w (weeks) d (days) h (hours)

Date

If dates are to be recorded then set up three separate columns and format
all the cells as Text. Numbers can then be entered as 01, 02, etc and years
prior to 1900 will be accepted in Excel®
First column = day (02, 12, 22)
Second column = month (enter first 3 letters only i.e. Feb, Sep)
Third column = year (1896, 1943)



Data is more easily combined than separated therefore separate columns are preferred for
dates



The apostrophe is next to the Enter key (for names like O’Brien)



Index names in advertisements (your family might have had a local business)



Don’t use any extra spaces, as these cause the electronic checking programme to think
there is an error



An index may include other fields as appropriate to the particular records



Key what you see – this may be at variance to advice for indexing.



If you come across an error in the spelling of a surname, particularly at the beginning of the
name, then you may (after consultation with your team leader) add a new line with the
correct spelling and add the incorrect spelling in square brackets along with the reference.
For example Brown [see Borwn], ref 6285.

Source
Sometimes a source may need to be included with each entry. The source reference must be
sufficiently detailed to take the user back to the original entry.
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Instruction Sheet
An instruction sheet should be set up for each project. This could include abbreviations used for
a particular project. For example you could be indexing funeral directors and one had a name
like Tasteful Funerals Limited so instead of keying this, the instruction would say key T and a
macro would convert this to the correct name at a later stage. Another instruction could deal
with ages expressed as years and months. Care needs to be taken in compiling this instruction
sheet so that it is easy to follow.
Checking
It is preferable to have two sets of the same data keyed by different people, which can be
compared by an electronic checking programme. Acceptable, but less desirable, is line-by-line
checking by an independent person.
Sample Index
A Sample Index (Partial) showing data entry and some common errors follows for your
information.
Some Excel® Tips


To access Excel® on a computer:
Click on Start then click on Program. Click on Microsoft Office (sometimes you can omit this
step) then double click on Microsoft Excel.
Note: Your computer may have an icon for Excel on the desktop, in which case a double
click on the icon will open the programme



If you want to repeat the same data as in the cell above:
Hold down the Ctrl key and press the apostrophe key (next to the return/enter key)



To keep the headings showing whilst scrolling down the page:
Using Excel 2000® or Excel 2003®
Put the cursor in cell A4. In the Window menu click on Freeze Panes (a line will appear
under the headings, and this will remain at the top of your screen).
Using Excel 2007®
Put the cursor in cell A4. Click on View then click on Freeze Panes.



To format a column:
Using Excel 2000® or Excel 2003®
Highlight the column by clicking on the letter at the top of the sheet. In the Format menu
click on cells. On the Number tab click on Text then click OK.
Using Excel 2007®
Highlight the column by clicking on the letter at the top of the sheet. Click on Home then on
(Cells) Format. Under Protection click on Format Cells. On the Number tab click on Text
then click OK.



To repeat a page number down the page:
Enter the same number on two lines one under the other. Then click into the first line and
continue to hold the left mouse button, dragging it down to highlight both numbers, then let
go. This will leave a small square in the bottom right of the lower cell. Move the cursor over
the small square until a black cross appears. When this happens, hold down the left mouse
button and drag the numbers down the page to your desired location.
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St Josephs Convent School, Feilding 1906-1966

EXAMPLE

NZ.MWT.SCH.FEILDING
Some Common Transcribing Errors
Surname
Hanratty
Kelly
Stock
Kieran
Andrew
McKeefry
Hanratty
Kelly
O'Meara
Augustine
Borgia
Johnston
Gleeson
Augustine
Rose
Borgia
Augustine
Quinlan
McLeod
Clausen
Woods
Redwood
Kirk
Fidelis
Broughton
Shortall
Cahill

TM
P

Rev. Father

(Meehan) Josephine
(Cooper) Benigna
(Murphy) Bernadette

M
M
M

Sister
Sister
Sister

13
13
13

Meehan
Cooper
Murphy

M Josephine
M Benigna
M Bernadette

Sister
Sister
Sister

13
13
13

Father
Father
Archbishop
Archbishop
Father
Father
Mother
Sister
Father
Rev Fr
Rev Fr
Mr (Mayor)
Mr
Mr

15
15
15
15
15
15
17
17
17
31
31
31
31
36

Moreau
O'Meara
Redwood
O`Shea
Harnett
Whitaker
Adrian
Kieran
Hanratty
Kinsella
Crowley
Short
Kelly
Greening

Given Names
T
J
M
M
P. T. B.
P. J.
T
J
M
M
W
Bill
M
M
M
M
E. M.
ED
HD
Tenison

P

T
J

Title
Fr
Mr
Mrs
Sister
Sister
Archbishop
Father
Rev
Sister
Sister
Mrs
Sister
Sister
Sister
Sister

Reverend
Archbishop
Dean
Sister
Father

Page
1
1
1
1
1
2
3
4
5
5
5
5
6
7
7
8
8
10
10
10
11
11
11
12
12
12
13

Comments

Omit full stops
Omit full stops

Omit full stops

Omit full stops

Exceptions: This is how these names
appeared in the book, but they will not
sort properly if entered this way.

Enter like this

Correct use of apostrophe
Incorrect use of apostrophe

Mayor' should be in the comments field

Key exactly as in the original - unless there are unusual characters in the surname field which will not sort correctly, as in the
example above.
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Saving Your Work
It is important to remember to save your work regularly as you go. It would be very
disappointing to have done a number of hours indexing and something unforeseen happens
(like the power goes off) and your data is lost. All your good work and time gone to waste!
Saving as you work:


After completing 5 lines of work it is suggested you save your file.



Using Excel 2000® or Excel 2003®
In the File menu click on Save As – this will bring up a dialogue box and at the top left hand
side are the words “Save in” and the window will display the last used folder. The options
are: choose this folder, select another folder using the drop down arrow or make a new
folder by clicking on the “new folder” icon and giving it a new name, for example, Indexing.
At the bottom of the dialogue box are two windows – the first window has the words “File
name” and a default name like “Book1”. Click into the window where Book1 is displayed and
type a name for your file. This name should be as directed by your leader, or something to
identify the work you are doing. Unless directed otherwise the second window “Save as
type” the default type can remain. Click on Save.



Using Excel 2007®
Click on the Office button (this is the round icon at the top left hand of your screen) then
click on Save As – this will bring up a dialogue box. The left hand pane will display
Libraries and under that Documents – click on Documents. Choose a folder from those
displayed or make a new folder by clicking on New Folder and giving it a new name, for
example, Indexing.
At the bottom of the dialogue box are two windows – the first window has the words “File
name” and a default name like “Book1”. Click into the window where Book1 is displayed and
type a name for your file. This name should be as directed by your leader, or something to
identify the work you are doing. Unless directed otherwise the second window “Save as
type” the default type can remain. Click on Save.

Making a copy on a Flash or Pen drive, or a floppy disk:
Insert your removable media (flash drive, pen drive, floppy disk, or other media) into the
appropriate slot of your computer.


Using Excel 2000® or Excel 2003®
Click on File and then Save As. In the Save in window use the drop down arrow to locate
the drive where your media is located. The following are the usual names and locations on
most computers:
Floppy disk
3½ Floppy (A:)
Flash / Pen drive Removable Disk (E:) to (H:)
Click on the drive then give your file a name in the File name box and click Save.



Using Excel 2007®
Click on the Office button then click on Save As. In the Save in window use the drop down
arrow to locate the drive where your media is located. The following are the usual names
and locations on most computers:
Floppy disk
3½ Floppy (A:)
Flash / Pen drive Removable Disk (E:) to (H:)
Click on the drive then give your file a name in the File name box and click Save.
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